E Dataflex

Welcome to the introduction of DataFlex 20.0

DataFlex is a complete software platform for rapidly developing and deploying Windows, web, mobile and cloud
business applications - fast! It is one of many products Data Access Worldwide has delivered to the software
development community since 1976. DataFlex is for application development and is available as a Commercial
Edition, which is used by businesses, institutions and government agencies to build and deploy applications, and as a
Personal Edition, which is a free, fully functional edition that can be used for non-commercial, private use.

At this point, you should have installed the DataFlex Studio. If not, before you read through this introduction, make
sure to download a copy from www.dataaccess.com and install it.

Once you have DataFlex Studio installed, you will be ready to follow through this document to learn the steps
involved in building a basic database application with DataFlex that includes data entry and reporting. Once you get
the basics down, get further into the underlying programming language and framework to take advantage of the
whole range of features that DataFlex has to offer.

First, let’s start by covering some concepts important to fully understand the DataFlex framework.

Object oriented

DataFlex is an object oriented programming (OOP) language. This means that all common components belong to a
pre-defined class. The classes hold the definition of how such components look, function, and what they exactly do.
Components are defined as objects of certain class in your application and that guarantees consistency and
reusability of code throughout your project.

A major advantage of using OOP is that a lot of technical details are defined in the classes and you can concentrate
on the real functionality of the application you want to develop customizing components as you need.

WorRspace

Before you start a project, you need to create a new environment where all the elements of your project — such as
programs, objects, and rules — will be stored. That environment is called a workspace. A workspace is a set of folders
in which the database, source-code and all files necessary to your project are stored.

A workspace can hold one or more projects, which are the eventual programs or ‘executables’. In the Studio,
Workspace Dashboard gives you an overview of the workspace and more details are displayed in Workspace Explorer
and Code Explorer. You can also see a workspace’s directory structure in the Configure Workspace Properties dialog
under the Tools menu in the Studio.

Database

DataFlex can work with any popular database management system (DBMS). DataFlex comes with the necessary
database Connectivity Kits that allow you to utilize those DBMS in your project, but for the purposes of this
introduction we will limit ourselves to the embedded DataFlex database, our native database.

Databases are maintained in the DataFlex Studio. The Studio allows for the creation of tables, the definition of
business rules and custom coding.

At a later time, you may easily convert native tables to any other supported database backend using the available
DataFlex conversion tools that will not only perform the conversion of table structures but also their existing data.

Data Dictionary

Data dictionaries are the business rules in your workspace that keep your data accurate and consistent. For example,
before saving records, the entered data needs to be validated — states should be uppercase and of a certain value,
and customers may not order more than the value specified in his credit limit.

Those validations are referred to as business rules and the files where they are stored are called data dictionaries. All
applications using data dictionaries will follow those same rules and if any rules change, only the data dictionaries
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need to be adjusted and the new rules will be applied throughout all applications.

Having data dictionaries also means that if you were to migrate the application to another database platform, the
same business rules will automatically be applied no matter what database backend is used. Data dictionaries are
created and maintained via the Data Dictionary Modeler in the Studio.

Our Example Scenario: Media

We will build a small database application that we will call Media. We will create a table Media in which we store all
our CD's, DVD's, Books etc. Next, we will make a table named People to store the names of friends and relatives.
These two tables will be linked to each other in such a way that you can keep track of the location of each item in
your media library.

This example will take you through the following steps:

e Create a project named Media
All components in a workspace must be created while there is a project active
e Create a table named People
The table needs a unique key and columns to store address, phone-number, date of birth, etc. of a Person
e Create the Person Data Entry View using the Data Entry Wizard to enter data into the People table
A view in DataFlex is a window, a non-modal screen dialog to enter data
e  Compile the program and test our first results
e Create a table named ‘Media’.
This will have a unique key and a few columns to store Author (/Artist/Writer), what type and maybe the price
and purchase date. In the table we also store the PeoplelD, to be able to relate each row to the Person table
e Manually, by using drag & drop, create a view to enter data into Media

e  After that, we will build in some more advanced features:

Make sure that the Media- and People ID’s are automatically generated sequential numbers
Put user-friendly pop-up lists (selection lists) in the application to easily and quickly find records in
Media and People

o Ensure consistent format of the way the column Media.Type is entered.
We will create a combo box for it and make sure the user always enters the types in a consistent
manner

o Enable the user to store a picture with Media

G e tt i n g S ta rte d ! New Workspace Wizard

Workspace Name
Start the DataF|EX StUdIO We will Enter a name for your workspace,
begin by creating a new workspace. . .
From the File menu, choose New Name of the New Workspace: Wizard selections completed.
’
: Medi .
Workspace... Give the workspace a [Medi Workspace Settings
name - in our examp|e, we will name Workspace Description: * Name: Media

‘Media

it Media and store it under « AppHtrIPath: C:\Projects\DataFlex\Media\AppHtml

= AppSrcPath: C\Projects\DataFlex\Media\AppSrc

C\PrOJeCtS\DataHeX\Medla ' = BitmapPath: C\Projects\DataFlex\Media\Bitmaps
s . Workspace Root Directory: = DataPath: C\Projects\DataFlex\Media\Data
After clicking the Next button skip the [CProcctoDaterieaieds) « DdSrcPath: Ci\Projects\DataFlex\Media\DDSrc
- . = HelpPath: C\Projects\DataFlex\Media\Help
Database Connection wizard page as « IdeSrcPath: C:\Projects\DataFlex\Media\ldeSre
we use the embedded database Enter the directory folder where your project's fi |* ProgramPath: C:\Projects\DataFlex\Media\Programs
. . . ) i will create it for you, X .
Prior to closing the wizard you will see Connection Settings
a Summary Of the gathered Ne SQL Connection |Ds have been defined.

information and what to do next.
. Upon completion of this wizard you may wish to:
The leard creates the SeIECted Connect to existing tables using the Database Connect Wizard.
fOIderS for the Media Workspace and Create new Tables using the Studic's Table-Editor,
returns to the Stud|0 SO that YOU may Click "Finish" te generate your new workspace,
take the next steps.
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Note: Workspace information can be altered later on via the - X
DataFlex Studio and - if folder renaming is desired — the N

Windows Explorer. .
p B e

The Dashboard

After the workspace has been created, the DataFlex Studio will
open the workspace dashboard. The dashboard is feature that

guides you through the application development. The Projects
dashboard gathers information from the workspace and shows
what you may want to pay attention to. o Create a project

The dashboard as shown here says that the next step is either
the table or project creation. We will first create the project.

Tip: Keep the dashboard open and notice that it will
automatically update during the whole process of application
development.

» Learn more...

Tip: At any time in the project development, you can add
TODO markers that are picked up by the dashboard. This
means you can use the dashboard as a project management

Database

o Manage Server/Database Connections

W
tool. i rrosta s Esbla
The next step is to create a project. For almost everything we create in ;' e e e D;“gp e Toob
ew ’ roject...

the Studio we need an active project. There are several ways to come to
the same point where you create a project. For example via the File pull-down menu, option New, and Project but
you can also click the ‘Create a Project’ option in the Workspace Dashboard.

This will open a dialog in which we select “Windows Project”, usually
Create a New Windows Project the first option in the set of icons. This choice displays a dialog where
you then enter the filename and path of the project. The path
defaults to the source path of the workspace created.

Directory Path: |C:\Pruje(ts\DataF\Ex\MEd\a\AppSr( |

File Name | Click OK and you will see the file Media.Src is created on disk and
(fno extenson entered,defoultfs tarc?) Media is made the current project. The project file contains a panel
with @ menu structure, default toolbars and an area where we can
work with our data entry and report views.
coneel For now we will not discuss this further and focus on the creation of
a table in which we enter data.

Creating the People Table

The next step in the process is to create one or more tables. Tables can be created in the DataFlex Studio. As usual,
there are several ways to start the table creation. For this document, do this via the Table Explorer. Make sure you
have the Table Explorer window open. If Table Explorer is not open — by default you will find this window on the left
hand side of the screen, grouped together with Code Explorer — you can activate it via the View pull-down 1
menu, Table Explorer option or the button positioned in the views toolbar.

Table Explorer

amE ® BYe "1 On the left you see the Table Explorer window. The list in the middle shows the tables
‘ already present in your workspace.

EFCOD
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The buttons above the list can be used to create or edit a table for modification, view the contents of a table, refresh
table definition, sorting and/or filtering the list of tables and as last one opening the SQL Connection Manager.

RiEEE T _ % The same functionality can also be found in the floating menu that can be opened
= 6] iR with a right mouse click in the Table Explorer window. In the floating menu you will
notice a couple of data dictionary options. We will discuss the use of the data
dictionaries later.

E Create New Table...

= Edit Table
#83  New <CODEMAST> Alias Table...

@ _View Table Click the “Create New Table” button (first button) or choose the “Create New Table”
option from the floating menu.
In the dialog you should enter the name of the table — People — |k
in two of the input fields (labeled Table Name and Root Name). Managed SQL  Embedded  Other
The table number value can be changed but the suggestion is
Table Name: |m |
good to go.

Table Number: *_

Press the OK button will instruct the DataFlex Studio to open a Roct Neme: [Pecple |

Table Editor for the new table we are creating.

The Table Editor panel contains areas with Columns, Indexes
and Relationships information.
The column information is editable via a grid in which you can
specify the names of the columns and their type, length and main index. Create the table to match the following
screenshot.

Tt Name: [Popie (1) Descrpton: [pecpi | If you would like, you can enter more
columns; you might want to store the size
of their shoes, their hobbies or an e-mail

Cancel Help

E,Add Column  Salnsert Column  Ex Delete Column

Name Type Size Main Index .

Peopleld Numeric 50 address. Feel free to do so. The quick

LastMame ASCI 40,0 . .

Fisthlame Ascl 200 introduction assumes you have created

Address ASCI 40,0 H

o e 20 the above columns of the given type and

Sy asa a8 size. To identify a specific row in the

Comments Tet People table create the column Peopleld
' as a key-field.

In order to look up people, we will create
a couple of indexes. Let us suppose we want to allow to search by LastName, FirstName and Zip. We need to create
an index for each one of those columns and each index need to be unique by itself.

The picture shows that the second index Indexes  Relationships

consists of two segments: LastName and SRS TR el

PeoplelD, the latter making the index Indees Index Segment: S, Add Selnsert SxDelete  SePromote Fq Demote
unique. Also notice that the checkbox R - Descending _ Ignore Case
Ignore Caseis checked. This means that Index 3 Zﬂiﬂa E

Index 4

when a user searches on “Johnson” the
order in which it is found is not dependent
on whether it is typed as "JOHNSON",
“johnson” or “Johnson”.

The tab has two toolbars. One - with the buttons “"Add Index” and “Delete Index” — and this works on the list of
indexes making it possible for you to add or remove a complete index while the other toolbar works on the grid with
index segments. Change the order of index segments with the "promote" and "demote" tool-bar buttons if they are
in not in the desired order.

Save the table structure for the table People by pressing the key-combination or click the Save tool-bar button.
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The Business Rules

When a column is marked as a key-field e ——

(‘Protect value (Key)' attribute) the value Closs Nome: T EEEERERTIE | superciss: DataDictionary ot
cannot be changed after the record has been Columns Validation Objects  Structures  Problems

created. PeoplelD is used to link the records T s

between the later to be created Media table Columns 4 Appearance -
and the People table and for this reason we *E:ftﬁ::e o

do not want to allow this value to be changed. fraame v

To indicate that the PeopleID column is a key- i:y z:fukmem

field, we need to modify a setting in the data Phone 4 Data Entry Options

dictionary for the table People. While the data Camments Aol e

dictionary class is automatically created when Copock ==

we created the table, it is not opened for Display Only False

editing yet. To open the data dictionary, right e e

click the table in the table editor and select el ==

“Open Data Dictionary” from the menu. Reaured e

One new tab-page in the code editor part of Retain Alvays  False

the DataFlex Studio will open and the focus T

will be on the DD modeling tab. Tl Mz
Click the PeopleID column in the list of :ottctttfh'?(fﬁlgdt N

columns and find the option “Protect Value

(Key)" in the list of properties as shown to the
right. Change the value of this setting from
False to True and the key field will be set.

While we are on this screen we can also add a couple more Business Rules:

e  Make sure that the column LastName is always entered — select LastName from the columns list and set its
Required attribute to True

e Make sure that the Zip and City are always stored in uppercase — select Zip from the columns list and change
the Capslock attribute to True; then repeat the same for City

We need to save the table and data dictionary to disk. Either save each one independently, or use the Save all
option. If you select the Save all option you also save changed source code which might be a good idea anyway. You
may still undo changes after saving them as long as you do not close the file. Closing a file would affect the undo
stack and you may not be able to undo all the changes.

Data Entry View

Create New...

We can now create a data entry View EE Dialeg / Lockup 3 Web Object #3 Class B Other Creates a data entry form for a

. . . iew /. datab iew.
and we will do so with the Data Entry 0 Project View/ Report stobase view
) S ) =i = This wizard supports singl
Wizard. Again, click on File, New and B Bl e el
now View / Report and the Create New (PG DateEntry Tabbed View WinPrint2  WinPrint2 eyoutisngiagnd fonthe
. . . View Wizard View Report .. Top Do... child table.
panel just like the one pictured on the .
. . . E Fields may also be arranged
rlght will be dlsplayed. . into tab pages.
Easic.Report
As you can see, there are a number of View
wizards and templates available. Choose
the ‘Data Entry Wizard’ icon and click
OK.
Enter the following information while Project: | Media.src v Cancel Help

processing the wizard:
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e 0oPeople for the object name

e People for the file name

e  People for the description

e Create a simple data entry screen. Choose
Simple Form Entry View.

e Choose the People table (the only table available

at this time).
Data Entry Vi
Entry Fields
Select the fields to be used in your view
EEliEts Mave Down
= FA People Peaple.Peopleld
B Peopleld Add -> People.Lasthame
g LastName G, | Peoplefimsttiame
-—-Tab Page---
E Firsthiame People.Address
B A.ddrass <-Remove | |PecpleZip
E zip People.City
B city <<-All [-—Tab Page-—
B Pheone PeoplePhone

B Comments People.Comments

Tab Page ->>

The order of the selected fields determines their position and tab order in your view.

< Back Next > Cancel

On the next wizard page you can indicate whether you
want to see the labels aligned left (always placed on the
left hand side of the controls) or Right and change the
text of each label. In the screenshot you see we
selected Right for the label justification option and
changed one of the tab-page labels to “Address”.

You can click the button labeled “Preview” to see what
your screen would look like.

You can now click Next and Finish to be brought back to
Studio. In the Studio, the View that the wizard has
made for us will be loaded automatically. This can now
be easily modified simply by dragging components with
the mouse, resizing them, etc. If you did not change the
labels of the tab-pages, we advise you to give the tab-

Data Entry View Wi

Names
Names used in your View Component

Please enter an object name for the View (e.g., oCustomerEntry)

[oPeople |

Please enter a file name (without extension) for the View Component. (e.g. CustomerEntry)

Enter a description for the View Component

[people

The object name is referenced by the project to open the view.

This new component will be added to the project:
Media.src

< Back Cancel

As shown, place all the columns on the View.

Add two Tab-pages as indicated so the View will be
better organized. In the end, the Entry Fields wizard
page should look like as shown to the left.

Data Entry View Wizard

Labels, Alignment and Preview
Select labels and alignment for fields, labels for tzb pages and preview the results

You may now select names each entry control and each tab-page. Entry Field labels can either be
right or left justified. If you select the same line checkbox the control will be placed on the same line
as the previous control,

Field Name Label Same Line
(A — T O
People.LastName LastName O
People.FirstName FirstName O
---TAB PAGE--- Tab Page Label O
People.Address Address O
People.Zip Zip O
People.City City O
---TAB PAGE--- Tab Page Label O
People.Phone Phone O
People.Comments Comments O

Label Justification

@) Left ORight Defaults Preview

<Back Cancel

pages another name now. To do this, under the menu-item View, open Object Properties and click with the Mouse
somewhere on the tab-page of which you want to change the label. In the list of the Properties, find “Label” and
change it to “"Address” and the other into “Other”, or whatever you find appropriate.

Tip: If you cannot find the Label in the properties list, you have clicked on the tab-dialog or somewhere else. Make
sure to dlick in the tab-page (body) itself and try again. For a visual clue, the corners of the selected object need to
show white block markers if the page is selected and black when the container is selected.

You are now ready to test your first DataFlex application. To do so, the project needs to be compiled. Based on the
generated source-code, the compiler will make an executable (.EXE) that will be what is run; your application. The

testing can be started in different ways:
1. Press [8| to only compile.

Media.src |~ I:I 0
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2. Press [Fs| to run. When compilation is needed, the compiler will be automatically launched.

3. Choose the Project pull-down and select Compile.
4. Click on the little green triangle icon in the toolbar.

If you selected option 2 or 4 and the compilation is finished, the application starts. You may bring up the People view

and you may now enter some data. Notice

7 People

=l = =]

the following: —

e  Begin with the first person by using Lastame Claus
PeopleID '1'. The next is '2' and so on Firsthame Sarta
(more about this later) | address [ Other |

e Save data by pressing the [F2] key, or T —
clicking the save icon on the toolbar Zip NP-0001

e Clearing the screen can be done by ciy

(the row will not be deleted)
e Once you have entered multiple rows,
you can browse through them by using

(Previous) and [rg| (Next)

. and [rg] work only if the cursor is
placed in the columns PeoplelD, LastName, FirstName or City because these were the columns that we defined

indexes on

e Key in a partial name in LastName and hit . This will find (equal) based on the given (partial) string. Try this!

Close the application to return to the Studio.

New Table Media

The creation of
the table for
Media is the
next step in our
process. So click
again the New
Table button in
Table Explorer.
Enter the value
'Media' for the

table and the root names. Then create the columns as shown below.

Note:

e In the column Type we want to record the type of the media — CDs, DVDs, BOOKs etc.

Table Name: Media (2)

=, Add Column

Sulnsert Column | =xDelete Column

Description: Media

Nare
MedialD
Title
Author
Type
PurchaseDate
Price
Comment
Peopleld

Type Size
MNumeric

ASCH

ASCH

ASCH

Date

MNumeric

Text

MNumeric

e PurchaseDate is a Date type column
e  Price is numeric with the 4.2 format. This indicates that the price can have 4 digits before and two after the

decimal point.

60
400
400

60
60
42
1024,0

Main Index

=B Media
g Columns
=R Indexes
=24 Indexd

. B Recnum
=34 Index 1

i. § MedialD
=24 Index2

LB Title

i. § MedialD
=24 Index3

B Auther

. B MedialD
=24 Index4

B Type

i. § MedialD

L

e The column PeopleID will be used in the relationship with the People table. We will, therefore, ensure that it is of

the same type (numeric) and same size (6 digits) as the column in the People table.

MedialD will be the key field. Create an index for it as well for Title, Author and Type. To make those indexes unique,

add MedialD as last segment for each index and select the Case Insensitive option.

Tip: Until now we have explained that an index is there to quickly and easily find a record. Indexes have another
Important function, which is fast sorting in reports. It is not difficult to create more indexes at a later time if you need
this for certain reports.
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The Media table will contain records of our media in the possession of a certain person. In technical terms this means
there is a relationship between the tables Media and People. Therefore, let us create the relationship between the

Indexes Relationships
=

Relationships

Relationship Column Pairs:

Add a Relationship (Filtered List)

Select a Parent Table:

i) 1 - People
EH 253 - CodeType
B 254 - CodeMast

oK Cancel Help

Outpul

length of the related

Indexes Relationships

F Add Relationship =7

Relationships

two tables. Choose the tab-page named Relationships and choose the first
toolbar button (Add relationship). A dialog with tables pops up and you should
select the table People from this list. Relationships are almost always defined
from many to one, so in this case, from Media to People.

The selection of the parent table opens the option to specify from which child
column(s) to which
parent column(s) the
relationship is made.
The column type and

Relationship Column Pairs:  E,Add  Sx Delete

=} People

Peopleld

columns must match.
The parent column (usually the key-field) must be uniquely
indexed. The result should look like the picture on the right.

Business Rules for Media

Finally, we will add some more business rules in the Data Dictionary. For this, the table needs to be saved first. The
MedialID column will be a Key Field and the Title column is required. You should be able to do this with the guidelines

given with the People data dictionary.

From Media To People

Peopleld

The values for Type should always be entered in uppercase (the Capslock attribute needs to be selected), but let us

Class Name: ‘cMediaDataDictionary |

Columns Validation Objects  Structures Problems

) Add Validation Object &) Remove Validation Obié

Create a new validation object

Validation Objects Object:

making a
report.
Therefore we will make a simple
validation table on the column Type. You
do this via the Validation Objects tab-
page. Click the “Add Validation Object”
button and enter the following information
in the dialog.

The column selected for the Validation

add something extra. We want the user to use consistent naming when entering
Types. If it is a CD-Rom, its Type should be entered as 'CD'. If it is a book, it should
always be entered as 'BOOK'. If such details were not entered consistently, think
about how difficult it would be to make a selection ('Show me all books') when

Create New Validation Object

Object Mame: ‘DMed\aTypes

‘ Apply to Column:

Type:

(O Validation Table (1 - column)

® Description Validation Table (2 - columns)
(0) Code Validation Table (database)

Type Value:

[J8 MedialD ~
[ Title

18 Author

g

[J8 PurchaseDate

1B Price

[JB Comment

[J8 Peopleld v

object is Type and the type of the validation object is — as shown — the description validation table. Enter the object
name as specified. Object names at this level need to be unique.

P Add Validation Object T Remove Validation Object

After you clicked the OK button you can start entering values

Walidation Objects Object: |oMediaTypes Class: |Desq
Woveiistpes |
_ F— Feel free to add more optional
co €D-Rom Types_
DVD-M DVD Music
DVD-V DVD Video
BOOK Book B DataDict.pkg |
SW Software ) W Columns
OTHER Other

‘Q cMe 5 Locate in Editor
~B Mec g Properties <oMediaTypes>  Ctrl+2

Via one of the properties of the validation table =

you can indicate whether the value may be left blank or not. If the value of
Allow_Blank_State is not set to True, the user must select a value from the list when
creating or editing a row. Configure this setting as you please.

for the table. We suggest you enter the values as shown.

Properties Lox

Object: ‘oMadiaTypes

DescriptionValidationTable

Properties  Binding Events
G
4 Behavior

Allow_Blank State 12y -

Delegation_Mode MNo_Delegate_Or_Error

Main_File 0
Static_State True
Table_Title Media Types

Validate_State True
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The user can pick one of the options from a drop-down list or a look-up list. If using the look-up list — which is the
default — the Table_Title property setting becomes important to give more explanation to the user about what the
purpose of the dialog is.

Tip: As a side note, take a look at the tab-page called Structures where you can see that the People table obviously
[s added to the structure with Media. This is a hint that validations do not only apply to single tables; related tables
are also validated.

Creating the Media Data Entry View

The second view we create will be the Media Data Entry View. This time the wizard will not be used to
create a data entry View. This means you will
learn how to make a data entry view in ain a
plicwa less automated way and will have more control Object Nome: |oMedia |
over what happens. From the menu under
File, choose New, View / Report, but now click on the
second icon: Data Entry View.

Create a New Data Entry View

Directory Path: C:‘\_F'roiects\_DataFle:<:‘\_|\41edia‘\_)'% Srq) |

File Mame: |Med|a.vw |

(If no extension entered, default is "ww")

After that, enter "oMedia" for the object name and the file Caption: |Media |
on disk will be named "Media.Vw". The Caption value is the This component will be added to "Media.src”
text displayed in the view’s caption-bar. p—

Tip: The screen indjcates that the component will be added
to the project Media — it will also be placed in the menu of the application automatically.

A new concept: Data Awareness

Before we continue, let us explain a new concept: Data Awareness. DataFlex is a tool to build database applications.
After the first sample we saw that it takes a View (interface) to enter data into the database. The several components in
the interface are apparently coupled to the underlying columns in the tables. That is right, that is exactly what happened.
But in fact there is an extra layer in between; the Data Dictionaries. DataFlex knows different types of components. An
important difference is whether components are 'data aware', or not. If they are, you only have to assign Data Dictionary
objects (DDQ’s) to it in order to have the desired data (tables) at your disposal. Data aware web controls make use of
data binding usually via an Entry_Item statement.

You are now looking at an empty dbView in the Studio. The first thing we need to |DDO Explorer [Medizann] 1 x
do is to decide which tables we want to maintain in this View. In the menu, under e 0&H &3
View, open DDO Explorer. In DDO Explorer no tables are selected yet. Adding a ‘

DDO is done via clicking the "Add DDO" button. You can do the same from the
floating menu.

Add s New Data Dictonary Object el In the dialog that opens you have to select the right data dictionary for this
Class Name Table Num new view. Since we want to edit (create, modify, delete) the table Media,
cPeopleDataDictionary People 1 select the cMediaDataDictionary class )
i i i . DDO Explorer [Mediaww] Lox
(highlighted in the picture). M R S
The 'Table Filters?' checkbox applies 22 DDOs for oMcdia

¢ 1[0 cPeopleDataDictionary
H:l cMediaDataDictionary [Main DDO]
% DDO Column Selector

the filters defined for the Table
Explorer to this list. This helps when &
the workspace' database contains a

large number of tables.

< >

[ Table Fitters? o] Help
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The Studio automatically makes the DDO for the Media table the main DDO and because Media has a relationship to
a parent table (People), the DDO for that table will also be automatically added. When the choices are not correct,
you can change these via the floating menu on each of the DDOs and apply the change. In our example this is
correct, so we keep the default settings.

From the DDO Column Selector select all columns of Media

“ e e (select all but the Recnum 5 & DDO Courn Selector
Tite: | ‘ checkbox) and drag them 00 cPeopleDatabictionary
Author | \ onto the View. Similarly, drag B'E'gu‘héed;iffﬂ'“'°m[Ma'" oeel
e | & drop the column LastName ' E Medad
Ph:t L 1 from People table onto the B Author
— ‘:1 | | View. Align the object with E .
T the PeopleID column. E ::mm
Remove the label-text from g
LastName using the Object
Properties.
. . - _ Change oy =i
the layout in such a way that it looks similar to what is i
pictured on this page. For example, all labels are right aligned Tt [Buddy Hly & The Picks ‘
at a distance of 2 from the control. Author: [Buddy Holly \
To see what the application looks like after it is compiled and ,,h?z
started, you click the run button or press . price:
Peopleld: 1| [Claus
Enter a couple of media rows. Let the Media ID start at '1' and Comment: | H
choose the Person related to it. Once you have created a few
media records, use [F7] and [rg| to browse through the data.
The Order in which Data is Entered

When you changed the positions from the controls for the

columns PeopleID/LastName and Comment, as in this sample, you will notice while entering data that the order in

which you navigate through the controls has not changed accordingly. We can change the position the controls are

displayed in the View, but that does not automatically change the order in which you navigate through the controls.

We can easily adjust that: From the menu, under View, open Code Explorer. Under the object oMedia, select the
object oMedia_Comment and right-click on it. Now move the entry two positions down

0D %% (Choose 'Move Object Down' or [Alt+DownArrow]). This takes care of that. You can also do
this from the toolbar button at the top of the pane.
Automatically Generate Key Fields

For People as well as Media we defined unique, numeric keys. This number stored in those

key fields is in fact not relevant to the user. In addition, it would be troublesome for users & oo
to remember what the last given number was when they try to create a new row. This can @ cesehisTe.

easily be taken care of; it only takes two steps:

1. Create an extra table. In this table we will always store only one (1) record. This is called a system table. In this

#8 Create New Alias Table...

table we define two columns only: LastPeople Workspace Dashboard % System [Table Editor]” X
a.nc_l LastMedia. These columns are numeric, 6 Table Name: |System () Description: |System
dIgItS Add Col I Col Delete Col
- . . . E Sulnsert S Delet
2. The Data Dictionaries of Media and People will ¢ el e bem see o
take care of generating these ID's Narne Type Size Main Index
automatically, using the system-file LastPeople Numeric 6.0
Vi 9 y Murmeric 6,0
Create the System table to match the picture 0

displayed on the right.
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To make sure it actually becomes a system-file, select True for the "is system

file" table attribute. Save the table structure before continuing.

Table: System
We want the Data Dictionaries to automatically increment the ID each time a 3: System
new row is saved. Open the data dictionaries for the tables People and Media Table Properties
— in the Studio. Look for the attribute Auto iCo :mm .
[ systemlsiegia | INCrement (Grouped under Other) in the e DATARLEX
list of attributes for the columns PeopleID 4 :';':;mme cwrm
(in People) and MedialD (in Media) and click the prompt button. From the list oot name System

of tables, select System and from the columns the correct source data column # Index

last index number

— those are LastPeople for PeopleID and LastMedia for MedialD. primary index
4 —Misc
Note: The value can be taken from a system table or a parent table. That is Fimp_':;si;" . f—f“E—mmp'E“—"ﬂ”e
n Eg!l chec rue
why you see the checkbox labeled "Show System and Related Tables Only’. Tue -
lock type df_lack_type_file
Ok. This should work, if not it is because you have already created some max records ! "
rows, with ID’s 1, 2, 3 etc. The first time we will use our automated increment | issystem file
function It (df file_is_system_file) Indicates whether the table is a
4 Other : . 41 .
will try save a row with ID of '1' and that will not
Auto Increment _ _ i i ,
Default Value Select Auto Increment Table and Celumn work because that value already exists. ID’s
should always be unique — it is a key field! Our
Entry Message B 1- People X y q Y
Exit Message G 3- System new application cannot save any new rows. We
Validation Message B LastPeople could delete our existing rows, but there is
=] LastMedia another way to solve this.
Auto Increment

Specfies the Tabie Colugg 3 Right click the "System" table in the table
| b Show System and Related Tables Only L. explorer and choose "View Table". The contents

Close Help of the table is opened in a tab-page in the design

area of the Studio.

Change the value for LastPeople and LastMedia to the highest used number. Let us assume that the last ID you have
entered was 10. Then enter the value 10 for both the LastPeople and LastMedia. Next time a row is created, the IDs

will be automatically set to 11. System [Table Viewer] X

As an alternative you can do the same — and more — via 4 4 5] » I» W X H & i
another useful tool from the Studio Tools menu: Database X
Explorer Recnum LastPeople LastMedia

[

Database Explorer (often called DBExplorer) provides a quick
means to directly edit data in tables. It is a typical tool for
developers, but be careful if you use it as it bypasses any safety or validations you have built into your applications.

The first thing we have to do is to make it possible to change data. By default, Database Explorer is configured in its

most secure mode which is set GH Database Explorer 20.0 (64-bit) - (Media)
to Only a”OW data to i File Record Database Window Help

be viewed but not : C enle EBE w-Ta -
. . 2 2 System
edited. Therefore, click on the 1 | ’
|Itt|e Icon at the Very bOttom-Ieft List of Tables Table Attributes
to change it from a red colored Tables ] Data 28 Indexes [ Columns ¥ DDO's/Fiters [ Attributes
. - Code Maintenance Code Tabl
icon (read-only mode) to a gray SR Code Maintenance Type Table Recnum  LostPeople  LostMedia

one (full-access mode). g o ! 0 "

HE
Table

Filters: 0/0 Filelist: c\Projects\DataFlex\Media\Data\Filelist.cfg Rowld: 01000000 CAPS MUM SCRL .«
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Data Dictionary changes

Before we compile and test our application, cMediaDataDictionary.dd [Dafa Di.. X
let us make two more improvements. Open
the Media data dictionary if it is not already

Class Name: |cMed\aDataDi:tiUnary Superclass: DataDictionary Table: |

Columns  Validation Objects  Structures  Problems

open. In Columns, highlight the column * oy =
v= &
Type, go to the group Appearance, find the Columns 4 Appearance -
option "Visual Control" and select "Combo". MedialD ;hg LL*;‘I
. . . Title ort Label
Every time this column is dragged to a new Author -
view during development, we want it to be a = Tope Mask Type
PurchaseDate Mask
combo-box by default. For the same column, Price Status Help Checkbox
. - . Data E Opti Edit
in the group Data Entry Options, find the po” e Fn;m
option "Capslock" and select True. —_ Auto Find GE i
Canslnck True

Then, highlight the column MedialD and in
the Data Entry Options group, set "Auto Find EQ" to True.

Change the Type Control

The change we just made (visual control) will only be applied when dragging the column to a new view, but we
already have our media view, we need change the control used for the Type column by editing the view. In Code
Explorer find the object oMedia_Type. Right-click on the object name in Code Explorer and select "Locate in editor"
to have the Studio take you to the source code of the object. The code should look like the following:

| Object oMedia Type is a dbForm
Entry Item Media.Type
Set Location to 50 &0

It is a dbForm, but we want it to become a dbComboForm object. Change the code to:

Object oMedia Type is a dbComboForm
Entry Item Media.Type
Set Location to 50 &0

Author |

Press the [F7] key. This toggles the Studio between design and source-code views Type:
and the dbForm has been visually changed into a combo box. Make the combo PurchaseDate:

box a bit wider and press [F5| to compile and start the application. Notice that it is
now no longer necessary enter to ID’s (PeoplelD or MedialD) when creating a new row.

We have made the following improvements:

e The ID’s for People and Media are automatically serialized/incremented

e Filling in an existing ID at Media and pressing the Tab key immediately after will automatically find the Media
that goes with that ID, this is what Autofind EQ does. It makes sense to make the same change on People ID as
well

e Entering data for Media Types is easier now: it is always uppercase, and may be selected through a combo-box,
which is the appropriate visual control for this type of data-entry

e  Setting the Appearance of Media.Type in the data dictionary to combo-box will always display this column as a
combo box by default

cMediaDataDictionary.dd

Note: By changing the type of control manually we may need to add a USE statement e e et
to the component file in order to have all the definitions needed in its own source code. Jee DEmrry - pRe ko
That will keep the component file self-contained and autonomous. In our case, the

project will compile and run, but there are situations where that is not going to happen. So, to keep our component
file autonomous, add "Use Dfcentry.pkg” to the list of USE statements at the top of the component.
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Selection Lists

We can make more improvements: If there are only a
few rows in the tables, it is not a problem to find the
right data using [F7] and [rg], but we must offer a better
way for finding the right data for when the tables grow.
So we will add look-up lists, also known as Selection
Lists.

From the File menu in Studio, choose New, Dialog /
Lookup and start-up the Lookup Wizard. Let us first
make a selection list for People, in which we place
LastName, FirstName and Phone (number) on the list.

We accept all defaults on the other wizard pages and at
the end, we compile the program again (). You can

Lookup List Wizard

Column Fields

Select Fields

Select fields to be used for each column in your Lockup List. E

Move Down Move Up

= FH People
B Peopleld
B LastName
B FirstName
B Address
B zip
B city
B Phone

[

People.LastName
People.FirstName
People.Phone

Add ->

All->>

<- Remove

<<- All

Auto ->>

The Auto option adds all fields that participate in an index to a list. This is often a good way to start!

<Back Cancel

see that buttons are automatically added to LastName and

B People
_— Firstname (Prompt Buttons).
eoplel
Lasthlame Clicking on the prompt button (or pressing ) brings the just
Firsthlame LestName Firsthame created selection list to the screen, offering the following
Claus Santa . .
Address Oty : standard functionality:

e Depending on the column in which the cursor is, the sort order of the list changes accordingly
e Simply start typing the desired LastName and a search dialog pops up. Pressing will take you to the closest
row. Because we use indexes, finding rows in a set of just a few rows will be as fast as when searching a row in

a set of a few million!

Now it should be easy to create a selection list for the Media table. Maybe you want to try another to use drag &
drop instead of using the wizard. In that case, here are some tips: Choose File, New, Dialog / Lookup: Table Lookup.

Enter “oMedialLookup” as the object name.

Code Explorer [Media.sl] 4 ox
& i B B
28 %% =
B Windows.pkg O
B DFClient.pkg Title Author
B <DbCIGridPromptList.pkg
B cPeopleDataDictionary.dd OhJE=t=|°|\fIEtha_T‘tlE \
B cMediaDataDictionary.dd
L& Media s Class cDbCIGridColumn
@ oPeople DD . Properties Binding Events
6 oMedia DD = A
£ oSellist - 24
[N TextColor clNone -
L) oMedia_Author 4 Behavier
& oPeople_Lasthame A || Auto_label State  False
@ 00K bn " Delegation Mede  Delegate_To_Parent
@ eCancel bn pbAllowDrag True
Q) oSearch_bn pbAllowRemove  False -
phCanslack False

Use the DDO Selector to choose the
correct tables (hint: Select the Media
Datadictionary) and columns (hint: Title
and Author from Media and LastName
from People).

To change details in the new look-up or
one of the columns (including their order)
use Code Explorer and the Properties
panel. There are many options you can
change and control. For example, by
default users are allowed to remove

columns from the list. If you do not want that, you can change the list property called pbAllowColumnRemove or the

column property pbAllowRemove.

One of the tasks automatically performed when using the Table Look up wizard is the connection of the lookup list
with one or more columns from the table via the data dictionary.
Since we did not use the wizard this time, we need to make these

connections ourselves.

4 Lookup/Validation ~ -
. s MName
‘Win Lookup Object
‘Web Lookup Object
Validation Type <nene>
4 Other

config
| ] Media.s!
|j Peoples!

Win Lookup Object
Sets the object id of a prompt-list obj
in 2 Windows application. This list is

W oo 4 %
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Open the Media data dictionary (if no longer opened), click the column(s) for which you want the oMedialLookup to

appear and select the Media.Sl file for the column property Lookup Object.

Show All Media Borrowed

Let us do something a bit more advanced. It is not so difficult to create a View where a user can browse through
People and display in a grid all the Media that each person has borrowed. The control used here is called a

cDbCJGrid, which can be found among the Data Controls in the Class Palette.

To browse through People and show only the . == =
appropriate Media, we need to create a view Nome: [BE 2] [cius |
with a constraint, i.e. a filter. Title Author Type -
Buddy Holly & The Picks Buddy Holly €D-Rom
Here is how you can do this: et Tongue chrity Meore 0 fom
. agical Ring anna -Rom
e Create a new empty View (Select Data 20 Great Love Songs The Beach Boys €D Rom
- 40 Jaar Hits Reb de Nijs [Disc 3] Rob De Nijs CD-Rom
Entry VIeW template) 80's & 90's Greatest Hits Cyndi Lauper CD-Rom
° Use DDO Eprorer to select Media and Aangenaam Barok 1993 Franz Listz Chamber Orchestra Featu...| CD-Rom
Aguaplano (Disc 1) Paclo Conte CD-Rom
People Back In Time Volume 03 Little Richard CD-Rom
" Blik op de Tijd Urban Species CD-Rom
° Drag FIrStName and LaStName Onto the Careless Whisper Londen Starlight Orchestra CD-Rom
view Celtic Collection Vol 1 Paddy O'Cennor and Friends CD-Rom
. . Chanson de Légende (Disc 3) Edith Piaf CD-Rom
e Use Object Properties to change the labels Classic Moments Thijs van Leer CD-Rom
for FirstName and LastName Club Trapicana Volume 1 Wham! CD-Rom v

e Align the objects horizontally

e Remove the Prompt Button from the LastName column (find the Prompt_Button_Mode in the list of Object
Properties and set it to PBPromptOff). This does not remove the lookup list completely (you can still press [F4] or
select lookup from toolbar or floating menu) but it removes the visual hint. To remove the lookup list you would

need to add a line of code to the people data dictionary object

Object oPecple DD is a cPeopleDataDictionary

; X : 0wl @ m
Set Field Prompt_Object Field People.LastName to 0

DDO Explorer [oWhoHasWhat.vw]

Hu | B

End_Object (&% DDOs for oWhoHasWhat

@ cPeopleDataDictionary [Main DDO]
i @00 cMediaDataDictionary [Constrained to cPeopleDataDictionary]

e Check in the DDO Explorer if the constraint is set to People (see . DDO Column Selector

i isi i —cli i H i@l cPeopleDataDictionary [Main DDO]
Image)' If thls is not the Case’ rlght ClICK on the Medla Table In @00 cMediaDataDictionary [Constrained to cPecpleDataDictionary]

DDO Explorer and choose Add/Change constraint: Add constraint

on people (also check Main DD) and the structure should be as shown in the image on the right

e With drag & drop create an object of the cDbCJGrid class from the class palette

e  From the DDO Column Selector drag the columns Title, Author and Type from the Media table to the grid

Pictures

The very last enhancement we make to the Windows application is to add

pictures for the Media we catalog. Let us say that we want to store a picture with

each Media row. First, we need to change the table:

e Open the Media table and add a column named Picture

e  Specify the type ASCII, and a length of 255. The actual picture will not be
stored here. Each Media row will hold a reference to the picture location
(folder) and name

e Open the Media view again in Studio and make it somewhat bigger

e In the Class Palette among DataControls find the dbBitmap. Drag and drop
it onto the Media view

e In the Properties panel under the Binding tab-page, assign the Data Source
(Entry Item) to the Media.Picture column

e Compile and start the application ()

|?| = . Current Project: | Media.st

=E Media.src
= EE Views (31

Object: [oDbBi

i
]

Class dbBitn

Properties Bi

Data Server (:

]-—' oMedia_DD

The server
This is the pi

Set to Pre|

Data Source

Media Pictu

=-F8 oMedia DD
B Recrum
LB MedialD
LB Title

B Author
B Type

i B PurchaseDate
LB Price
LB Comment
g Peopleld
&

R oPeople DD
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In the application, find a Media row and double-click on the area where the bitmap should be stored. A common File
Dialog will pop-up. Select the image you want to store for that row and make sure you save the data!

Peopleld: | 1 | ‘C\aus |

Comment;

Note: Out of the box DataFlex "only"

5| Media [o] = ==
MiedialD: supports bitmaps (all images are drawn by
Tite; [Buddy Holly & The Picks \ Windows as bitmap) but via the free add-on
Author:[Buddy oy | Graphics Library you can add TIFF, JPG, GIF
Type: -CD .
S and many o_ther graphic forma_ts. The
Price: connection Is as easy as described above (we

only need to connect to the library and use a
different class name).

Reports and Lists

One of the most powerful ways to create reports and integrate them in DataFlex is by using DataFlex Reports and
the DataFlex Reports Integration Library. This is a wizard that automatically incorporates a report in your Windows
application. The end-user will be able to start the report from the menu and still be able to adjust the sort order,

output device, and even selection criteria. It is simple: First create a report with DataFlex Reports, and then start the
wizard — the rest is self-explanatory.

Note: If you do not have a license for DataFlex Reports, please contact the Data Access sales representative in your
region to receive an evaluation license, or to purchase a license.

Start DataFlex Reports and select File, New. Then choose Standard Report. You can also press the key
combination. In the wizard select DataFlex as your data source and point to the filelist of your workspace (in the data
folder). Select the Media table from the list of tables.

IR Report Creation Wizard

In the Fields wizard page select the columns Title and

Data Price.
Choose the data you want to report on.
IR Report Creation Wizard
Available Data Sources: Selected Tables:
B DataFlex > Fields
£l C\Projects\DataFlex\Media\Data\Fil Choose the infermation to display on the report,
[ People .
] Viedia =
ﬁ System Available Fields: Fields to Display: A
- FLEXERRS < = il C\Projects\DataFlex\Media\Data\Fileli > B MediaTitle
- CodeType = Media . B Media.Price
EH CodeMast . 8 Recnum .
ODBC g MedialD
Runtime Datasource - B Tt
- salite - B Author
- Repository g Type
B PurchaseDate
<=
- B Price
3
8 Pecpleld
< N - B Picture
Open...
< Back Cancel
< >
. . Browse Data... Find Field...
In the Grouping wizard page select the column Author.
The page summary, data filters and repository can be < Back Cancel

skipped for this report.

After finishing preview the report in the designer.

0°0ZA 3PIND UOIPNPO.U] INY SMOPUIM X3l4eeq | ST |



E Dataflex

To integrate the above report in your Windows project you will need to connect to the DataFlex Reports Integration

library (optionally installed with the developer edition of DataFlex Reports). The library comes with a Wizard to

integrate the report into your applications. The result of the Wizard is a Report View component, automatically added
to the

IR DataFlex Reports 2021 Developer Edition 8.0

{ File Edit View |Insert Format Database Report Window Language Help
de-u|&R RE|LSOD-C-BROBS| X 0% * i[@MicrosofthengHeilight -0 -||B I U T|F T | K A|A | -5,
{ZEE/ ORI EE &I 4w = Tk 0 G A S EE AR R SEEISIRA] 1«6 |[BR
MediaList.dr [Design] MediaList.dr [Preview] X | Field Explorer nox
€ Q|7 FlL |4
-2 Database Fields ~
£l CAProjects\Training Materia
& Media

B Recnum

LB MedislD

i B Title

- B Author

=B Type

i-E PurchaseDate

B Price

LB Comments

i-E Peopleld

& B Picture
[&] Parameter Fields
- f Function Fields
e Author
7= Group Name Fields
L Group #1 Name: Media.Autt
=100 Special Fields
o= Data Date and Time
= File Creation Date and Time

>

e File Path and Name
. Filter Function
. Group Number

e Modification Date and Time
o Page N of M
. Page Number

e Print Date and Time
. Record Number
. Report Author

e Report Category v

|e B >
Br B @ EA 0]

Records: 235 Page: 1 of 16

<

Reports pull-down of your current project. In the self-explanatory wizard you can select from five different kinds of
preview views. The third option gives the most freedom, the standard is the dynamic preview view. This makes it
possible to run multiple report and compare result. The big advantage of the report integration is the programmers
API that makes it possible to change filters, change data paths at runtime etc.

With DataFlex Reports you can fill an array of data in your DataFlex application and pass it to the DataFlex Reports
print engine as the data-source to print from. This makes it possible to create reports on data that is not in a
database.

i An alternative way of producing reports is by using Winprint. A Winprint Report is fully programmable in
DataFlex. Fortunately there is a way to create

B Printing Report: Media (WinPrint) = =

NinPrint2 . . . . .
]"F'.:;g;t Winprint Reports by using a wizard for a quick |l «  suts > bim glim | s [
WESEN  start. It takes just a few seconds to make a
report that lists all Media, with a break on Authors.
With a report fully coded inside the DataFlex programming e —
language you can process records while being printed. As I Y T S
an example you can flag an invoice as printed (store the ‘:e":n s b3 Tops
print date) while printing. }::"w" Danny .
itle ype
Grease een vette musical D
The downside of such a report, is that for every small }:f,:"“ Dave Bery e
change in the layout requested by your users, you need to T
change program code and redistribute the application. Of \3'“ — Toee
. . ays under
course this also increases your revenue. }:ulﬂwn Del Shannon .
itle ype v

0°0ZA 9PIND UOIPNPOIAUT HIINY SMOPUIM X3l4e3eq | 9T |



E Dataflex

Get Started!

This concludes this Quick Introduction Guide for DataFlex.

To learn more about DataFlex, visit the following sites to learn more about the product and its creator:

e  https://www.dataaccess.com/
e  https://learning.dataaccess.com

Other related sites:
e https://support.dataaccess.com/forums
e  https://www.dataaccess.com/dynamicai (Business Intelligence tool)

If the documentation, help-files or the forums don’t provide you with answers, feel free to ask for assistance via e-
mail. Visit the Data Access website for the support options in your region.

Another very good resource is new extensive training guide called “Discovering
DataFlex” that contains more than 600 pages. This book has been made available for
each revision of DataFlex since the beginning of 2008. Please contact your Data
Access sales representative if you would like to purchase a copy of this book. The
book is available in PDF format.

Discovering DataFlex

0°0ZA 9PIND UOIPNPOIAUT HINY SMOPUIM X3l4e3eq | /T |


https://www.dataaccess.com/
https://www.dataaccess.com/dynamicai

